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Information Services

	Exam Result Transfer Process User Guide


This document explains the process to transfer exam results to SIMS.

The steps in the process are:
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A. Running an Exam Data Extract in Business Objects Online
2

B. Saving the data as a text file.




3

C. Using and updating the data in Excel



6

D. Creating Files to transfer the data to SIMS


7

E. Transferring the Files to SIMS
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The document also includes:

F. Exams Email Reports – Explained



12

G. Sample Data – Possible Errors




14

You will need :

· A Business Objects Online Account with access to the SIMS Exam Reporting/Examination Results folder.
· An account for the Transfer Process (see section E).

· Microsoft Excel, Access or similar.

· To ensure your Internet security settings are set to Medium-Low  (To do this - Open up your browser, select Tools > Options > Security, and use the slider on the left to set the security level).

Contact Details
If you have problems with any of the instructions in this document please contact INSRV using the following email accounts.  Using these accounts will ensure that the appropriate members of the exams team responds to your problem as quickly as possible.

Business Objects Online
INSRVConnect@cardiff.ac.uk


Type BO Exam problem in the subject line of your email to ensure it is logged correctly.

Exams Files Submission/Processing, Exams Accounts


Sims-Exam-Support@cardiff.ac.uk

A. Running the Exam Data Extract in Business Objects Online
This step uses BusinessObjects to extract the student details you require from SIMS for the programme you administer.

1. Log into BusinessObjects 
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At the top of the Business Objects screen is a “Search Title” box.  Don’t mix this up with Internet Explorer Search which will be a larger button at the top of the screen.  Enter into this box “Exam Result Transfer” and click on the search button.
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3. You should see documents called:

Exam Result Transfer Extract (All) v2
Exam Result Transfer Extract (by Semester) v2
Exam Result Transfer Extract (Non-standard Starts) v2
(plus Resit Exam Result Transfer Extract which is not currently in use).
4. Select the appropriate document by clicking on its name. If you are running the extract:
· once only for all exams -> select All

· for the Autumn Semester and again for the Spring Semester ( select by Semester

· for courses with non-standard starts select ( Non-standard Starts

5. The document will now open in the browser.
6. This next stage eliminates a possible error and doing this could save you time later.  Go to the Document Menu, select save as, and then Excel.  If a popup appears asking you to Open, Save or Cancel, just click Cancel.  If a yellow bar appears at the top of the window as shown, click on it and select “Download File”, then continue on to step 7.
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7. Click on the ‘refresh data’ [image: image2.png]5. Refresh Data.



 icon at the top right and you will be prompted for parameters, which you should enter in uppercase.  Click on each of the questions to input the responses.
	Parameters
	Example

	Please Enter Academic Year in format yyyy/y
	2006/7

	Please Enter Dept/SubDept(eg ENCAP%, ENCAP1)
	WELSH%

	Please Enter the course code (eg PPMBBSA)*
(or enter % to select all courses)
	UFBAWEL

	Please Enter Occurrence(s) from list**
	(B) September

	Please Enter U for UG’s or P for PGT’s
	U

	Is this a Joint Honours Course?
	Y or N

	Please Enter a Year of Study or % for all (normally just leave as %)
	1,2,F or %

	If using the by Semester report:

Please Select Semesters from list (Press ‘Values’)
	SEM2;SEMD

	Please hold down CTRL key to select more than one value.  SEMD= double semester modules. SEM0 is non-modular.  Click OK when done.)
If you are selecting values from the list, please remember to press the 
‘
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’ button to choose the selected values.

Notes:

* If you don’t know the course (programme) code, you can look it up on SIMS Online

** Occurrence is the start month of the course.  For courses with a standard start, select “(B) September”.
	


8. Click on ‘Run Query’.  Refreshing the report and displaying the results should take a few minutes.

B. Saving the data as a text file
You will now have several reports containing student data relating to the course you have selected.  You can move from one report to another by clicking on the tabs at the bottom of the screen.

If any of the data appears to be incorrect, please contact Student Records queries for Schools on GroupWise or Schoolrecords@Cardiff.ac.uk  
You will notice that some of the columns contain no data.  You will be inputting data in these columns in Step C.

The data from the report now needs to be saved so that it can be used in Excel, Access or your chosen method.

1. Go to the Document menu at the top left of the screen, and select “Save to my computer as”, and then select “Excel”. 
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2. This panel is then displayed ( Select Save.
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3. Rename the file
NB: It is important to change the name of the file.  By default it will have the same name as the document; you should change this to be more meaningful name such as the name of the tab, e.g. SchoolResults.xls
4. Click Save and select an appropriate location to store the document.
C. Using the Data in Excel

Once you have saved the file, it can be opened in Excel or imported into Access.  There are various ways of doing this.  This document will now follow an example using Excel, you may have your own method which will work equally well.  Access works in a very similar way to Excel (but is not fully supported by BIS).

Using the data in Excel
1. Navigate to where you have saved your Excel document and open it, or Open Excel, select “Open” and find the document.   You will see that there are several worksheet tabs, one each for Mods, Year Results and Awards (and also User and Technical tabs but these are not required)
2. Once you have opened the workbook, delete the “User” and “Technical” sheets by first selecting them (left clicking on them), then right clicking on them and selecting Delete.
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E. Transferring Files to SIMS

The .CSV files must now be transferred to the “Exams System” using a secure FTP (file transfer)
package. For Windows users we suggest using a program called "SSH 3.2 FTP". See instructions
below. Apple Mac users should contact INSRV for details of secure FTP packages.

Before the Transfer Process can be used, your name, Network username and the IP address of the
computer from which the files are to be transferred must be given to INSRV who will arrange for an
account to be set up for you and notify you of your username and password via email.

The IP address can be found in Workstation Information which can be viewed by double-clicking on
the |

The transfer will only work from computers which have had their IP address enabled. If you have a
new computer at any time you will need to inform BIS.

Each username has its own password (not the Network password) which will be given to you. Both
username and password are case-sensitive so must be typed correctly.

Using SSH 3.2
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You will also need to set the format of the Mods, Year Results and Awards tab to Text.  You can do this by selecting the top left blank header section, shown in the figure to the right with a red circle around it.   Once the entire Spreadsheet is highlighted, go to the “Format” menu at the top of the page and select “Cells”. 

In the categories box, select “Text”, and then click ok.

4. Input data in the columns in the following reports:  The bold items highlight the data to be entered.

Mods Tab (SMR)
	Extract Field Name
	SIMS Field
	Max size on SIMS
	Example

	Surname
	INS_STU.STU_SURN
	40
	Bloggs

	Forenames
	INS_STU.STU_FNM1 + STU_FNM2 + STU_FNM3
	45
	Joseph William James

	SPR Code
	INS_SMR.SPR_CODE
	12
	0123456/1

	Module Code
	INS_SMR.MOD_CODE
	12
	BS1010

	Module Occurrence
	INS_SMR.MAV_OCCUR
	3
	A

	SMR Academic Year
	INS_SMR.AYR_CODE
	6
	2004/5

	Module Semester
	INS_SMR.PSL_CODE
	6
	SEM1

	Module Mark
	Blank
	6
	To be entered by you eg 56

	Module Grade
	Blank
	2
	To be entered by you eg PM

	Module Credits
	INS_SMR.SMR_MCRD
	6
	20

	Current Attempt
	INS_SMR.SMR_CURA
	1
	1


Year Results (SPI)

	Surname
	INS_STU.STU_SURN
	40
	Bloggs 

	Forenames
	INS_STU.STU_FNM1 + STU_FNM2 + STU_FNM3
	45
	Joseph William James

	SPR Code
	INS_SMR.SPR_CODE
	12
	0123456/1

	SPI Sequence No
	CAM_SPI.SPI_SEQ2
	2
	02

	SPI Progression Code
	CAM_SPI.SPI_PITC
	12
	To be entered by you eg PP


Awards
	Surname
	INS_STU.STU_SURN
	40
	Bloggs

	Forenames
	INS_STU.STU_FNM1 + STU_FNM2 + STU_FNM3
	45
	Joseph William James

	SPR Code
	INS_SMR.SPR_CODE
	12
	0123456/1

	Award Code
	CAM_SAW.AWD_CODE
	12
	BA

	Classification
	CAM_SAW.CLA2_CODE
	6
	To be entered by you eg 2-1, D


D. Creating Files to Transfer to SIMS

IMPORTANT

Before reformatting the data to send to SIMS ensure that all your work has been saved.

Saving Data file
Once the required data has been entered, you should save the file.  
Saving Data files as Excel

You may wish to save a copy of the file in Excel.  We recommend you do this if you haven’t input all the data (eg you’ve only entered the data for one module), and you need to return to this file for inputting further data at a later date.

Click on File > Save as and ensure the Save as Type is set to Microsoft Office Excel Workbook (*xls).  
Saving Data files as Comma Separated Values format (csv)

You need to save the data files as csv files to allow the data to be imported into SIMS.  

Before you save the files, you need to delete some rows and columns.  Delete:

the header row

the surname and forename columns
any trailing blank rows at the bottom of the spreadsheet

Do this by selecting the rows and columns, going to the edit menu and selecting delete.
The data in these rows and column is included in the extract for ease of data entry, but will cause errors if the data remains in the file when it is read by SIMS.

Data can be sent to SIMS in more than one file.  For example, you may wish to submit one file per module or per course.  Once the required data has been entered the report should be saved as a comma-separated (csv) file.  You will need to do this separately for each of the reports (Mod, Year Results, and Awards).
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1. From the top menu select File ( Save As…
2. Change the “Save as type” to CSV (Comma delimited)
3. Select where you want to save the file, then type an appropriate file name using the File Naming Convention.

2.1
File Naming Convention

The following convention must be followed for naming the file in order for it to be recognised by the transfer process and processed correctly.

a. File names should start with the three-character code of the table that they are updating in SIMS

Modules = SMR

Year Results = SPI

Awards = SAW.  

b. The next five characters should be the School acronym, e.g. WELSH, BIOSI, ENCAP.  

c. The next part needs to be unique within the School for example MOD123.  The length of this part of the filename is limited to 11 characters.  

d. The ’_’ (underscore) character must be used as a separator between items 1, 2 & 3 otherwise the transfer system will not recognise the file. 

e. The file must have a .CSV extension.

Examples of valid file names are:


SMR_EARTH_MOD789.CSV


SPI_BIOSI_YR2.CSV


SAW_WELSH_F03.CSV

4. Click Save.  Click OK and Yes if you are prompted by Excel.

5. The File name Must Not be more than 25 characters in length (including the .csv file type).

Remember to repeat these steps for all Mod, Year Results and Awards sheets.
Your files should now be saved in a format suitable for transferring to SIMS.  If you open the file in Notepad it should look like the examples below.

Example of Module (SMR) records:

000654138/2,PX2101,A,2001/2,SEM1,45,PM,10,1

000654138/2,PX2104,A,2001/2,SEM1,57,PM,10,1

Example of Year Result (SPI) Records:

000192321/1,03,PC

000392441/1,03,PP

Example of Awards (SAW) records:

990016846/1,BL,2-1

990697352/1,BL,2-2

For further explanation of this file format, refer to section G.
If any of the data in your extracts appear wrong, contact registry on the “Student Records Query For Schools” e-mail address which is:

Schoolrecords@cf.ac.uk

E. Transferring Files to SIMS
The .CSV files must now be transferred to the “Exams System” using a secure FTP (file transfer) package.  For Windows users we suggest using a program called "SSH 3.2 FTP".  See instructions below.  Apple Mac users should contact INSRV for details of secure FTP packages.
Before the Transfer Process can be used, your name, Network username and the IP address of the computer from which the files are to be transferred must be given to INSRV who will arrange for an account to be set up for you and notify you of your username and password via email.

The IP address can be found in Workstation Information which can be viewed by double-clicking on the icon located in the toolbar at the bottom of the Windows Desktop.

The transfer will only work from computers which have had their IP address enabled.  If you have a new computer at any time you will need to inform BIS.

Each username has its own password (not the Network password) which will be given to you.  Both username and password are case-sensitive so must be typed correctly.  
Using SSH 3.2

1. Start SSH 3.2 (Start ( Networked Applications ( General Software ( Internet, Web & Email ( SSH 3.2)

2. Click on the icon [image: image5.emf]

 to open the File Transfer window or from the Menu Select Window ( New File Transfer. 
3. Click on Quick Connect. 

4. Enter scholar.admn.cf.ac.uk in the Host Name box and your username in the User Name box.

5. Click on Connect.

6. Click on “Yes” when the info box appears if you are connecting for the first time.

7. Enter the password you have been given in the password box and click on OK.   The password will be in the format of your School/Department acronym  in capitals, followed by an underscore, followed by your username in small case.  (e.g. INSRV_sisbi  or COMSC_scobi)
8. Note that SSH will also try to start a terminal session in the other window: this will fail and give you an error message.  This is nothing to worry about and can be ignored.
9. You should now be connected to the system, and should be able to see a folder icon in the right-hand box with the name "Inbox".  You cannot open this folder for security reasons.

10. You must ensure that the files are submitted as ASCII files, to do this make sure the ASCII button is active (see below).

11. Find your files in the left-hand box and click the file(s) you want to copy.
12. Transfer files by dragging files from the left side and dropping them ON the Inbox icon. If you drop the files outside the icon you will see an error message.
13. Once you have transferred all your files click on the Disconnect icon.

[image: image6.emf]


The files will be picked up by an automatic process and loaded into SIMS.  The process runs every five minutes during exam periods, but if there are a large number of files to be processed before yours there may be some delay.

You will receive an automatically generated email when the file has begun processing. You may also be sent further emails which will tell you if any errors were found with the data.

These email reports are explained further in section F.  If you have not received a confirmation email within an hour of submitting your files contact BIS.

F.   EXAMS EMAIL REPORTS - Explained
1
Email Subject: EXAMS UPLOAD REPORT


Content

The following file is being processed: 



Filename.csv

Any errors will be sent in a separate file.

Description: This email is sent as soon as a file begins processing.  This is simply to inform the user that the file has been picked up.  Users should note that if they haven’t received this email with 60minutes of submitting the file, they should get in touch with BIS.

2
Email Subject: EXAMS ERRORS


Content


There are errors in the file:


Filename.csv

Attachment sent containing errors will be have a file extension of .txt and you must double click the file to open it.

Description: This email is sent if there are formatting errors in the file.  These errors 
include:


Incorrect length student codes


Missing fields


The student names have been submitted in the file


An alpha character where there should be a numeric


Etc.

All lines containing errors are not processed and are sent back to the user as an attachment with the email.

All valid lines are processed as usual.

3
Email Subject: EXAMS ERRORS


Content


ERROR IN FILE:


Filename.csv


This file could not be processed due to inconsistent data (e.g. duplicate rows).


--------


optional


--------

 
There were also data formatting errors.  See attached file.


(Attachment sent containing errors)

Description: I think the only time this would be sent is when there are duplicate rows in the file.  This would also send the data formatting errors described in Report 2.
4
Email Subject: EXAMS UPLOAD ERRORS


Content


Error report for the file: 



Filename.csv

Attachment sent containing errors will have a file extension of .lst
Description: This email is sent if there are problems uploading the valid lines to SIMS because the file being uploaded contains different data.   
The error can occur because an individual has manually added an incorrectly formatted record to the extract.  
An error can also occur for award records (SAW file) if the expected end date of a student on SIMS is not the current academic year and so the award date does not match the academic year on SAW e.g. a student could have an expected end date of 30 June 2012 and so the award year would be 2011/2 on SAW.  If you try and upload this award it will be rejected because the award year will be the current academic year of 2010/1.
Errors could include:

Incorrect Student Code


Invalid Module – i.e. student is not recorded on the module on SIMS

Invalid SPI Seq Number 
Invalid SAW 

A file containing the errors is sent to the user as an attachment to the email.

Error report for the file :
File.csv
 
To display the contents of the attached file:
1. Right click and select View from the drop down list.
2. Scroll down to locate the start of the file.
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G.   SAMPLE DATA – Possible Errors
This section is designed to illustrate the possible errors that can occur in data being passed to SIMS

SMR RECORDS




1. SPR Code



Correct File Format






Field

1            2      3     4          5       6   7    8  9


010876168/2,PX2101,A,2006/7,SEM1,45,PM,10,1

010876168/2,PX2104,A,2006/7,SEM1,37,PM,10,1

Incorrect File Format 

A few examples of errors that can occur in an SMR file
Field

1

        2
          3          4                         5             7       8     9

 10876168\2, px2107,a,20006\7, Sem1,FC,A, 0

Incorrect length.


Leading zero missing


\ instead of /


Space in field


Lower case instead of UPPER case


Lower case instead of UPPER case


Too Long


\ instead of /


Space in field


Lower case instead of UPPER case

Exam Mark (field 6)missing


Character instead of numeric


Space in field

SPI RECORDS







Correct File Format






Field

1       2    3



010876168/2,03,PC
010876168/2,02,PP
Incorrect File Format 

A few examples of errors that can occur in an SPI file
Field

1

    2
 3
 
10876168\2, O2,pc

Incorrect length.


Leading zero missing


\ instead of /


Space in field


Character O instead of numeric 0 (zero)

Lower case instead of UPPER case

SAW RECORDS







Correct File Format






Field

1       2    3



010876168/2,BL,2-1
010876168/2,BL,2-1
Incorrect File Format 

A few examples of errors that can occur in an SPI file
Field

1

    2
 3
 
10876168\2, bl,2.1

Incorrect length.


Leading zero missing


\ instead of /


Space in field


Lower case instead of UPPER case


Incorrect separator (must be 2-1

not 2.1)

SPR Code		6. Module Mark


Module Code		7. Module Result


Module Occurrence	8. Module Credits


Academic Year	9. Current Attempt


Module Semester





SPR Code


SPI Sequence No


SPI Progression Code








SPR Code


Award Code


Classification
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